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Chapter 1 ¢ Introduction

Description

The AML M7140 is a programmable stationary terminal for fixed station, wired, or
wireless industrial data collection applications. The M7140 features a standard Intel
StrongARM® processor, Compact Flash card slot, and 10 BaseT Ethernet connectivity.
Extensive 1/0 interfaces include two RS-232 ports for bar code scanners or other serial
devices, three optically isolated inputs, and three relay contact outputs for integration
with PLCs, conveyors, scales, and alarm devices.

The M7140 Stationary terminal has a rugged powder-coated steel enclosure, 77-key
elastomeric keypad, a 2 VGA backlit LCD display, an internal speaker, 32MB DRAM
memory, 16MB Flash ROM, and compact Flash storage up to 32MB. The M7140
stationary terminal integrates easily and quickly into a wide range of computing
environments. Each M7140 comes pre-loaded with VT100/220 terminal emulation, a
TELNET client, FTP server, and an HTTP server. Optional software tools provide
support for Windows® ODBC and OLE DB data sources, or C++ development under
Linux®.

More information about M7140 terminal features can be found atjwww.amltd.com|

Picture

Supported Equipment Manual e March, 2006 1-1


http://www.amltd.com

Introduction

Setup Requirements

Installation requires, at a minimum, the following:
e an Intel 80386 or 80486 CPU
e 32 megabytes of RAM

e AT-standard (16-bit) hard drive controller

Accessories
Accessories for the M7140 terminals include:
e Commandlink™ Application Development Suite

e Radio Card - 11 Mbps Wireless

Linux Kernel

Version of the Linux Kernel

The version of the Linux kernel on the M7140 terminal is 2.4.19. (The RAM disk
image version is 1.0.0 and the AML bootloader version is 1.2.1-DT.)

Finding the Version of the Linux Kernel

The version of the Linux kernel will appear on a terminal screen when the terminal

is rebooted. For rebooting instructions, see the Booting the Terminal section of
Quick Start.

Release Notes

1. After download (either using a serial cable or changing emulation using
Airloader), the terminal MUST be rebooted for changes to take effect.

2. The Scanner tab is not relevant for the M7140.

3. The Scan/Decoder object is not functional for the M7140.

1-2
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Chapter 2 - Terminal Setup

Installation
The InstallShield wizard runs and presents the following screen.

Welcome

YWelcome to the Poweri et TwinClient Setup program.
Thiz program will install Powert et TwinClient on pour
- cornputer.

[t iz gtrongly recommended that pou exit all Windows programs
befare running thiz Setup program.

Click Cancel to quit Setup and then cloze any programs pou
have mnning. Click Mest to continue with the S etup program.

WIARMIMG: Thiz program iz pratected by copyright law and
international treaties.

|Inautharized repraduction or diztribution of this pragram, or any
portion of ik, may result in zevere civil and criminal penalties, and
will be prozecuted to the maximum extent pozsible under law.

Cancel |

Click on Next to begin the installation process.
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Terminal Setup

Choosze Destination Location

Setup will ingtall PawerM et TwinClient in the following folder.
Toingtall to thiz folder, click Mext.

Toinzstall ta a different falder, click Brovwse and zelect another
folder.

Y'ou can chooze not toinstall PowerMet TwinClient by clicking
Cancel to exit Setup.

" Destination Folder

C:5Power et TwinClient Browse... |
Cancel |

To change the default Destination Location, click on Browse and select a location. Then
click on Next.

¢ Back

Select Program Folder E

Setup will add program iconz to the Program Folder listed below,
f'ou may twpe a new folder name, or select one from the existing
Folders list. Click Mest to continue.

Program Folders:

E wisting Folders:

Adrminiztrative Tools [Common) -
Adobe Acrobat 4.0

Lotus Applications

Microsoft Office Toolz

M artan Antiins

1] Etn 22

Startup
‘windows MT 4.0 Option Pack =

< Back I Mest = I Cancel |

The default folder is PowerNet. This default may be changed either by selecting an
existing program group or by typing in a new name at the prompt. Then click on Next.
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Running the Manager

Setup Complete

Setup haz finished copying files to your computer,

Before you can wze the program, you must restart Windows or
your cormputer.

= Yes, | want to restark my computer o

™ Ma, | will restart my computer later,

Remove any disks from their drives, and then click Finish to
complete zetup.

¢ Hack I Finizh I

When the installation is complete, reboot the system to initialize the Twin Client
software.

a. To reboot the system immediately, click on Finish.

b. To reboot later, click on the option to restart the computer later, and click on Finish.

Running the Manager

The PowerNet Twin Client Manager is the utility that manages the terminal software and
configurations.

Select Start, Programs, PowerNet, and Twin Client Manager. The PowerNet Twin
Client Manager screen appears as shown in the following figure. This is the
administrator's main screen, and all functions are accessed from its menu bar, toolbar, and
tabs.

Menu Bar

The menu bar provides access to the functions used to configure the terminals and
manage their software.

E3untitled - Twin Client Manager O] x|

File Terminal ©bject Editors  Sektings Tools  Wiew Help

0|26 %% 2 2|
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Terminal Setup

Toolbar

Found under the menu bar, the toolbar provides shortcuts to major features. The toolbar
can be turned on or off by changing the Toolbar parameter found on the View menu. The
shortcuts available from the toolbar are as follows.

Create a new terminal configuration.

Open an existing terminal configuration.
Save the current terminal configuration.
Download the configuration to the terminal.

Download software to the terminal.

Configure terminals automatically over the wireless network.

= EEEE D

?

View the PowerNet Twin Client Manager version.

The PowerNet Twin Client Manager is now successfully installed and ready for use.
The next section provides detailed instructions for quickly configuring the terminal
and starting a Telnet session.

Quick Start
Configuring the Manager

The first step is to configure the Twin Client Manager to meet site-specific requirements,
and then prepare it for the automatic management of the terminal software and IP
addresses. This simple procedure will require only a few minutes to complete.

Setting the Emulation

Click on Start, Programs, PowerNet, and Twin Client Manager. Select the Settings
menu, as shown below.

E3untitled - Twin Client Manager =10 x|

File Terminal Object Editars | Settings Tools  MWiew  Help

N e

SEFVELS...

Click on Emulation, select the desired emulation, and click on OK.
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Quick Start

Emulation |

Select the terminal emulation type:

wt220
5250
3270

] I Cancel

Setting the Servers

The Servers are the Telnet host systems the terminals will access. To set these addresses
from the Settings menu, click on Servers.

Unl:il:led - Twin Client Manager -0l x|

File Terminal ©Object Editors | Settings Tools  View Help

Dlﬁ’vlnl .";Elrél ﬁl Ernulation, .. |

Click on Add.

Server Mame | IP Address | IP Port | T erminal Type |

[ ar

add | Edt | Deletz | Load. |
]9 Cancel |

Enter the name of each server, its [P address and IP port (normally 23 for Telnet servers),
and emulation type.
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Terminal Setup

Server Properties x|

Server Marme: I receiing

IP & ddress: IEDE.183.ET.155 Lu:u:ukupl
IF Part: I23

Terminal Type: I"-"t1 oo j

] I Cancel |

Click on OK.

Semer Name | IP Address | IP Port | Terminal Type |
receiving 20618367 15! YT100 Up

[ar

Al Edt | Delete | Load. |

] | Cancel |

Click on OK again in the next screen. Repeat this step for each Telnet server the terminals
are required to access. If an error is made in the name, IP address, I[P port number, or
terminal emulation type, click on the line that is in error and then click on the Edit button
to make the corrections.

Setting Terminal Operations

In the Twin Client menu under Settings, choose Terminal Operation.

Unl:il:IEd - Twin Client Manager -0l x|
File Terminal ©Object Editors | Settings Tools  View Help
Dlﬁlnl .';Elﬁl ﬁl Emulatiorn, ..

SErVErs...

Standard 5ettings | MNew-Environ Setkings. ..
Terminal Dperation, . . I |

Run Airloader on terminal can be selected, and the Airloader server IP address can be
entered.
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Quick Start

Terminal Operations El

I¥ Fiun ailoader on temminal

Airloader zerver |P address: I
= wiindows Swfindows CE options Cancel |

¥ | Bun application at startup
™ Hide task bar

™| Use GUI menus and screens

Code page; IEI
Scanner Serial Port: |<|:Iefault> vI

Click on OK when finished.

Setting Terminal Model

Under Settings, choose the Options menu as shown.

Untitled - Twin Client Manager -0l x|
File  Terminal Chject Editars | Settings Tools  Wiew Help

Dlﬁlnl ."Eilﬁl ﬁl Ermulation. ..

SErvers...
Mew-Environ Setkings...

Standard Settings |

Terminal Operation, ., |

Opkions...

Select M7140 and choose OK.
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Terminal Setup

TwinEIient Terminal Loader x|
b anufacturer: Terminal b odel:
M7100
AL
Fadio Type:

Communications Port: II:EIM'I vI

Cancel |

Saving the Configuration

Click on File and Save As. Enter a name for this configuration.

Unl:iI:IEd - Twin Client Manager _
File Terminal ©Object Editors Settings  Tools  Wiew Help

Tlew Chrl+M | ? |
Chrl4C %

Qpen, ..
| |

For the purposes of this example, the name is vt100.

=10l x|

Save Chrl+5
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Quick Start

2l

Save in: Iﬁ TwirClient j L £ Ef-

| terminal
sarnple, cf

File name: I'-fh 0. cf j Save I
j Cancel |

Save az type: ITwin Client Config Files [*.cf]

Setting Airloader Auto-Configuration

The configuration download and IP address assignment for each terminal will take place
automatically by setting the Airloader Auto-Configuration options.

E3untitled - Twin Client Manager O] x|

File Terminal ©bjeck Editors  Settings | Tools  Miew Help

Dlﬁlnl '[;ﬁlﬁl ﬁl gl Authorization, .. l:

Aitloader, .,

|
Click on the Airloader option in the Tools menu.
Note: If the Airloader Auto-Configuration window does not display the options, click on

the Advanced<< button.

If multiple network adapters are installed on the PC, ensure that the desired network
adapter is selected. The adapter selection can be changed by clicking on the Change
button.
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Terminal Setup

Terminal Auto-Configuration x|

=
The Terminal/Group Auto-configuration manager gives you
Mew Group [Default the ability to keep terminalz up to date automatically with the

latest settings and software. Use the default group, or create

additional terminal groups far mare complex environments.

Adwanced << |

¥ &llow teminals to be automatically configured via RF

¥ Synchronize Configuration Files
v Synchronize Program Files

™| Sprichronize Driven Files

™| Syrichronize BIOE Files

¥ Configure [P Parameters (local segment only]
Metwark Adapter:

I[EI] PCI Fast Ethemet DEC 2114 Ehange...l
Addresses... |

This powerful software management tool is described in detail in the Airloader Auto-
Configuration section of Software Management. For now, it is sufficient simply to use it
for assignment of the initial terminal configuration and IP address, both of which can be
casily changed later. Ensure that all of the check boxes are checked as shown above.

To assign terminal IP addresses automatically over the wireless network, check all of the
boxes as shown above. Then click on the Addresses button and enter the desired range
in the From and To boxes as shown in the following figure.

Segment Address Assignments

w1206.183.67.240 Agent Address: 206.183.67.217
Sggg: ggg;g:; Subnet Mask: 285255255128
[1206.183.67.243
[1206.183.67.244
[1206.183.67.245
[1206.183.67.246
[1206.183.67.247
[]206.183.67.248 Add
[1206.183.67.249

Address Range

From; IZDE.183.E?.24D To: |2DE.183.E?.249

Remaove | Select Al |

Remaowve Al |

[¥ Checked indicates address assigned

Cancel |

After setting the address range, click on OK to return to the Airloader Auto-Configuration
screen.
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Quick Start

Terminal Auto-Configuration

. rrinial/Group b anager
g8 Mew Group [Default]

Click on the * sign in front of Terminal/Group Manager to access the default terminal
group. Next, click on the New Group icon and use the Browse button to select the
configuration file saved earlier.

Terminal Auto-Configuration - Airloader x|

= @ Terminal)Group Manager
@ Meswy Group [Default]

¥ Active
Configuration File

I Browse... |

% Use default server file [power. net]

" Use a zaved server file [*.avi]

I Browse... |

— Auto-Group
[ Defaul
[ Manufacturer |20l j
™ Type M7140 ~]
™ Radin Prism2 ~]

[ Ermulation 3270

I- Segment [P Addiess 0.0.0.0
et Maszk: J00.0.0

Faorce Reload... Thin Maode... Schedule...

Check the Active box, and the system is now configured to automatically download IP
addresses, software, and configuration files to the terminals. Click on the [ box at upper
right corner to return to the main menu.

Note: The software does not need to be authorized now. It can be authorized later, after a
Telnet session has been established. The procedure is described in Authorizing
PowerNet under Standard Setup.

Booting the Terminal

To boot the terminal, hold the power key till the terminal goes Off and then power On.
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Terminal Setup

Starting a Telnet Session

At the Twin Client main menu on the terminal, press any key to establish the connection.
Until the terminal has been authorized, the following screen is displayed.

RECOVERABLE ERROR
Terminal not

Authorized for

Twin Client

Keypress to continue...

It is not necessary to authorize the terminal at this time, so press any key to continue. The
terminal will establish a connection with the host system and start emulation. If the
terminal fails to connect to the host, refer to the following tables for the possible causes
and the related corrective actions.

Failure Cause Corrective Action
Incorrect Host IP address | Correct the Host List address on the terminal. Refer to
Using Terminal Menus under Standard Setup.
Incorrect netmask value Correct the netmask value. Refer to Using Terminal
Menus.
Error Indication Possible Cause Corrective Action
NOT Associated Invalid NETID Run current radio setup program and
set NETID to match the access
point. See Using Terminal Menus.
Unable to open IP stack on terminal Reload Program Files and reboot.
connection failed to load.
Timeout waiting for | Transient Reboot terminal. If problem persists,
data communications check the RFSYNC.log in the
failure PowerNetTN directory.
Download aborted Socket closed during Ensure that PC is operating. Reboot
download terminal and retry.

After a Telnet session has been successfully established, the terminal will remain in
session for a maximum of 30 minutes at a time until it has been authorized. Once
authorized, there is no software restriction on the session time. The instructions for
authorizing the terminal are presented in the Authorizing PowerNet section of Standard
Setup.
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Standard Setup

Standard Setup
Setup Using Twin Client Manager

The Twin Client Manager provides a Standard Settings tab for automatic setup of the
terminals. The options within this tab vary according to the emulation selected, each of
which is described below.

VT Settings

Select the VT emulation setup by clicking on the Settings menu and then the Emulation
menu, as shown below.

E3untitled - Twin Client Manager =10 x|

File Terminal OCbject Editars | Settings Tools Wiew Help

|| 35 o/ IETE—

SEFVErs. ..

Then click on the VT100 selection, as shown below.

Emulation Pl

Select the terminal emulation type:

w220
5250
3270

s I Cancel

Click on OK after the selection is made, and return to the main Twin Client Manager
menu. The Standard Settings tab will now reflect the settings for VT emulation.
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Terminal Setup

Unl:il:IEd - Twin Client Manager - 10| x|

File Terminal Object Editors Settings  Toaols  Wiew  Help
0|3 %[ 25 2

Standard Settings |

Duadrant Mode | off -

Fant

Fort Size | i I

Ken Click v

Frinter Type: I none j

Ready [vb100 |AML M7 140 v

Quadrant Mode

The scrolling list option defines the rules by which the terminal display is positioned in
the larger host display. As defined by Twin Client, quadrants are fixed position
“windows” in the host display, and the terminal display is located on whatever quadrant
contains the current cursor position.

Off disables quadrant processing and Twin Client simply centers the current host
input field in the terminal display.

On enables quadrant processing. However, input fields that cross quadrant
boundaries result in a shift to the left in order to locate as much of the current input
field on the terminal display.

Soft always positions on a quadrant boundary regardless of input field boundaries.
Viewing keys are enabled.

Hard is the same as Soft except the viewing keys are disabled.

Lock locks the terminal display origin (upper left corner) to fixed row and column
(x,y) coordinates in the host display. The coordinates are zero-based.

Font

The Font Size scrolling list option offers a choice of size 10, 14, 16, 18, or 20 font.

2-14
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Standard Setup

Key Click

This check box enables (checked) or disables (unchecked) audible key clicks from the
terminal. The default value is on (checked).

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating
that no printer is attached.

5250 Settings

Select the 5250 emulation setup by clicking on the Settings menu and then the
Emulation menu, as shown below.

E3untitled - Twin Client Manager =10 x|

File Terminal Object Editars | Settings Tools  MWiew  Help

D= (| @|

SEFVELS...

Then click on the 5250 selection, as shown below.

X

Select the terminal emulation type:

k. I Cancel

Click on OK after the selection is made, and return to the main Twin Client Manager
menu. The Standard Settings tab will now reflect the settings for 5250 emulation.
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Terminal Setup

Untitled - Twin Client Manager =10l x|

File Terminal ©Object Editors  Settings  Tools  Wiew  Help
D|=|E| 6% 22 2

Standard Settings |

Quadrant Made | off -

Font

Font Size |'||:| vI

K.ep Click v

Printer Type: I hiore j

Ready 5250 [AML  [M7140
d | | | 4

Quadrant Mode

The scrolling list option defines the rules by which the terminal display is positioned in
the larger host display. As defined by Twin Client, quadrants are fixed position
“windows” in the host display, and the terminal display is located on whatever quadrant
contains the current cursor position.

Off disables quadrant processing and Twin Client simply centers the current host
input field in the terminal display.

On enables quadrant processing. However, input fields that cross quadrant
boundaries result in a shift to the left in order to locate as much of the current input
field on the terminal display.

Soft always positions on a quadrant boundary regardless of input field boundaries.
Viewing keys are enabled.

Hard is the same as Soft except the viewing keys are disabled.

Lock locks the terminal display origin (upper left corner) to fixed row and column
(x,y) coordinates in the host display. The coordinates are zero-based.

Font

The Font Size scrolling list option offers a choice of size 10, 14, 16, 18, or 20 font.
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Standard Setup

Key Click

This check box enables (checked) or disables (unchecked) audible key clicks from the
terminal. The default value is on (checked).

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating
that no printer is attached.

3270 Settings

Select the 3270 emulation setup by clicking on the Settings menu and then the
Emulation menu, as shown below.

E3untitled - Twin Client Manager =10 x|

File Terminal Object Editars | Settings Tools  MWiew  Help

D= (| @|

SEFVELS...

Then click on the 3270 selection, as shown below.

Emulation |

Select the terminal emulation type:

k. I Cancel

Click on OK after the selection is made, and return to the main Twin Client Manager
menu. The Standard Settings tab will now reflect the settings for 3270 emulation.
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Terminal Setup

E3untitled - Twin Client Manager O] x|

File Terminal ©bject Editors  Settings Tools  Wiew Help
D[ (W] 5[5 2 2

Standard Settings |

Quadrant Maode | off -

Fant

Fant Size vI

K.ep Click v

Frinter Type: I nane j

Ready 3270 [AML  [M7140
d | | | Y

Quadrant Mode

The scrolling list option defines the rules by which the terminal display is positioned in
the larger host display. As defined by Twin Client, quadrants are fixed position
“windows” in the host display, and the terminal display is located on whatever quadrant
contains the current cursor position.

Off disables quadrant processing and Twin Client simply centers the current host
input field in the terminal display.

On enables quadrant processing. However, input fields that cross quadrant
boundaries result in a shift to the left in order to locate as much of the current input
field on the terminal display.

Soft always positions on a quadrant boundary regardless of input field boundaries.
Viewing keys are enabled.

Hard is the same as Soft except the viewing keys are disabled.

Lock locks the terminal display origin (upper left corner) to fixed row and column
(x,y) coordinates in the host display. The coordinates are zero-based.

Font

The Font Size scrolling list option offers a choice of size 10, 14, 16, 18, or 20 font.
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Standard Setup

Key Click

This check box enables (checked) or disables (unchecked) audible key clicks from the
terminal. The default value is on (checked).

Printer Type

This scrolling list selects the attached printer type. The default value is none, indicating
that no printer is attached.

Using Terminal Menus

Press the Menu key to view the Main Menu, shown below.

Hafin Meni

Hetwork Setup
Diagnostic Henu
Local Settings
Linux Pronpt
Tools-Altilities

Cursor to the Network Setup menu option to change network setting information.

Hetwork Setup

<8ave Settingsr

Metwork Connection Info

IF 287.241.78.133
MASK :255.255.255.128
MAC :BE:68:B3:6A:81:16
BCST :287.241.78.255

Select Network Settings by pressing Enter. The following screen appears.

Hetwork Settings

O 108BazeT ®FCACLIA

CEtatic & DHCF CBOOTF

Cursor to the desired option, enter the correct information, and press Enter.

Press Esc to move backward a screen, and seclect Radio Settings.
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Terminal Setup

CAAL Metwork

122:23:24:25
Key 2 :30:31:32:33:34:35
Fey 3 :40:41:42:43:44:45

ode :Infrastructure

Press Esc to move backward a screen. Choose Terminal Options.

Local Echo

Cursor to Diagnostic Menu in the Main Menu to access the following options.

RF Signal Strength

Firmware Uersion

Choosing RF Signal Strength shows the screen below.

RF ﬂu-aliﬂ — 108
ﬁ. Slgml — 108

ﬁ. Noise - 13

ULAN: Comnected — AP
HAC: 00:62:2D:3E cAD:DE
T® Rate : 11 Hbps

Choose Ping Server to check the address to ping.

Firmware Vers ion

II?Z.H.IN.ZH

Select Print Test Label to select the printer.
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Standard Setup

irnware Uersion

delect Printer

Emure Fi

The Firmware Version menu option appears as follows.

Select Local Settings from the Main Menu.

Local Settings

erial Port Configuration
tartup Options
udio Settings

Scroll to Real Time Clock to view the clock.

Date/Time

UVt 04 :07 PM

<Save>

Choose Linux Prompt from the Main Menu.

From the Main Menu, cursor to Tools/Utilities.

Tools-Alilities

Az ic
et Change Fassuord

lear PMazsword

Refer to American Microsystems documentation for explanation of other settings.

Supported Equipment Manual e March, 2006 2-21



Terminal Setup

Authorizing PowerNet

Each PowerNet Twin Client will run for 30 minutes at a time without authorization.
Uninterrupted operation for a production environment is the result of authorizing the
software.

Automatic Authorization

The Twin Client Manager can automatically authorize the terminal over the wireless
network if the following requirements are met:

e A PC running Twin Client Manager is connected to the wire LAN segment with at
least one access point within range of the terminal.

o The System ID of the PC on which Twin Client Manager is installed has been used
to obtain a site license Authorization code from the Connect web site.

To obtain the System ID of the Twin Client Manager, click on the Authorization option
in the Tools menu, as shown below.

E3untitled - Twin Client Manager - O] x|

File Terminal <bject Editors  Settings | Tools  View Help

0 | B’ul El 1’5'%' EI EI ‘ Authorization. .

The Authorization window is displayed as shown below.

Authorization x|

Your Spztemn 1D s |[EBFZE305

Twin Client wersion: 7.0.0

Enter your Autharization Code belows;

Apply |

The spstem i HOT curently authorized -
Add Lizenses... |

—Authonized Terminalz

T otal Authonized: IEI—
In Usze: ID— Lizting... |
R emaining: IEI— |

Cloze
Dretailz... |

fd anual Buthonzation... |

Transfer Suthanzation,.. |

Go tofhttp://www.connectrf.com|. Click on Partner Services. Click on the Generate
Authorization icon at the top of the page. Follow the directions on the web site.
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Authorized Terminals

The number of terminals authorized, the number of terminals in use, and the number of
terminals remaining is provided in the Authorized Terminals box on the lower left side of
the screen.

Click on the Details button to number the options in the screen below in the order of your
priority.

Note: The terminal may or may not be able to utilize the Formatter feature depending on
its authorization codes.

Authorization Details x|

The following list shows the number of terminalz that can be
authorized by thiz Twin Client manager bazed on optionz
granted by zite icenszes.

Fe-order the entries to priontize which options are given to
terminalz authonzed by Airloader.

Pricrity | Dption| =] | Remaining |
1 Both Formatter and Plus n
2 Screen formatter only n Up
3 Twin Client Plus anly I}
4 Standard features anly I}
Droary

* Staging not enabled.

Cancel |

Click on an option and move it using the Up and Down buttons.

Click on OK when finished.

The Manual Authorization button is an alternate method of obtaining an authorization
code for a terminal. This method does not utilize Airloader, as does the other method.

Click on this button, manually enter your MAC (Media Access Control) address in the
appearing screen, and click on OK. You now can generate individual authorization codes.

Adding Licenses

The Add Licenses feature is used when adding additional licenses to an already site
licensed Twin Client Manager. (i.e. Twin Client Manager is licensed for 10, and the
customer purchases another 10 licenses to make a total of 20.)

From Twin Client Manager, choose Authorization from under the Tools menu. Click on
the Add Licenses button.
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Authorization : x|

Your Spztemn 1D s |[EBFZE305

Twin Client wersion: 7.0.0

Enter your Autharization Code belows;

Apply |

The spstem i HOT curently authorized
Add Licenses... |

—Authonized Terminalz

T otal Authonized: IEI—
In Usze: ID— Lizting... |
R emaining: IEI— |

Cloze
Dretailz... |

fd anual Buthonzation... |

Transfer Licenses... |

A pop-up box appears with the machine ID and a space for the additional license’s
authorization code.

x

Machine D IEDDE-EES?-?EEF

Authaorization Code; I

] I Carnicel

Use the machine ID in the pop-up box instead of the original machine ID to get your
authorization code.

If adding users, click on the Add Licenses button before generating the authorization
code to get the most current machine ID.

Transferring Licenses

The Transfer Licenses feature is used when moving a site license from one PC to
another. After Twin Client Manager is installed on a new PC, you will need the
system/machine ID for it.

From Twin Client Manager, select Authorization from under the Tools menu.
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Click on the Transfer Authorization button on the old PC. You will be asked for the
new system ID. Enter this new system ID. It will generate an authorization code for the
new PC's Twin Client Manager.

Authorization x|

Your Spztemn 1D s |[EBFZE305

Twin Client wersion: 7.0.0

Enter your Autharization Code belows;

Apply |

The spstem i HOT curently authorized
Add Licenses... |

—Authonized Terminalz

T otal Authonized: IEI—
In Usze: ID— Lizting... |
R emaining: IEI— |

Cloze
Dretailz... |

fd anual Buthonzation... |

Transfer Licenses... |

Note: This feature only works if there are licenses remaining on the old PC.
Listing

Click on the Listing button to view authorization codes used along with corresponding
serial numbers.

The authorization codes used along with their corresponding serial numbers will appear.
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Authorization Codes Issued x|

Sernial Mumnber | Autharization Code |

Click on OK when finished.

Click on the Close button when finished.
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Airloader Auto-Configuration

The Airloader Auto-Configuration form is accessed from the Twin Client Manager
Settings menu.

Terminal Auto-Configuration

E Terminal/Group Manager . . . .
The Terminal/Group Auto-configuration manager gives you

the ahility to keep terminalz up to date automatically with the
latest settings and software, Use the default group. or create
additional terminal groups for more complex environments.

Advanced << |

IV Allow teminals to be automatically configured via RF

v Synchionize Configuration Files
v Synchionize Program Files

™| Sprichronize Driven Files

™| Syrnichronize BIOE Files

v Configure [P Parameters [local segment onlyk
Mehwark Adapter:

I[EI] PCl Fast Ethemet DEC 2114 Change,,_l
Addresses. . |

Note: If no options are displayed, click the Advanced<< button.

Enabling Automatic Downloads

Click to put a check in the box that allows terminals to be automatically configured via
RF to enable automatic downloading. In the event another PC on the network is already

configured and active, the following warning message is displayed.
RF Sync Manager |

Inable to automatically configure terminals.
There iz already another computer of this netwark

segment running the AirlLoader zerver. [206.183 67 226]

Synchronizing Configuration Files

Click to put a check in the Synchronize Configuration Files box to enable automatic
synchronization of configuration files on the terminal. When the terminal is booted, its
configuration files will be compared with the most recent on the PC. The terminal is
updated automatically if it does not have the latest revision.
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Synchronizing Program Files

Click to put a check in the Synchronize Program Files box to enable automatic
synchronization of program files on the terminal. When the terminal is booted, its
program files will be compared with the most recent on the PC. The terminal is updated
automatically if it does not have the latest revision.

Automatic IP Address Assignment

New terminals will be assigned IP addresses automatically if the following box is
checked.

¥ Configure IP Parameters (local segment onluk
Metwork, Adapter:

I[EI] FCI Fast Ethernet DEC 2114 Ehange...l
Addreszes... |

Note: Do not check this option if a DHCP server is configured to manage address
assignments.

To set the addresses, click on the Addresses button to access the Segment Address
Assignments dialog box, as shown in the following figure.

Segment Address Assignments x|

+¥|206.183.67.240 Agent Addess: 208 18367217
gggg::gg:g;:g:; Subnet Mask: 255 265 265128
[1206.183.67.243
[1206.183.67.244
[1206.183.67.245
[1206.183.67.246
[1206.183.67.247
[(1206.183.67.248 add
[1206.183.67.249

Address Range

Erom: |2DB.183.B?.24D To |208.183.B?‘.249

Bemove | Select Al |

Remave Al |

[¥ Checked indicates address assigned

Cancel |

Enter the desired range in the From and To boxes as shown above, and then click on
Add.

Creating New Groups

New groups, with different configurations, can be created by clicking on the Terminal
Group Manager, and then clicking the right mouse button as shown.
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Terminal Auto-Configuration

E Terminal/Group Manager

Refrezh

MHew Group

After the new group has been created, the group settings option becomes available for
change, as shown below.

Terminal Auto-Configuration - Airloader x|
= EE Terminal/Group Manager _
@ Mew Group [Defaulk] [ Active
@ Mesw Groupl Configuration File

I Browsze... |

' Use default zerver file [power. net]

" Use a zaved server file [*.svi]

I Browse,.. |
—Awto-Group
[ Default
[~ Marutacturer | AL j
™ Type M7140 =]
™ Radin Prism? =]
I Emulation | 2270 =]
" Segment [F4ddress: [0.0.0.0
It b azk: J0.0.0.0
Force Reload... | Thin Mode. . Schedule. ..
After the Configuration File and all of the other parameters have been set, the group is
made active by clicking on the Active check box.
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Terminal Auto-Configuration - Airloader

=l EE Terminal)Group Manager
88 MNew Group [Default]

..... Y e Group

Setting the Segment

v Active

Configuration File

% Use default zerver file [power. net)

" Use a zaved server file [*.svi]

Browse. .. |

Brawse... |

—Auto-Group
[T Defaul
[T Manufacturer
I~ Type
[ Radin
™ Emulation

[T Segment P 2ddiess:

fet baszk:

AML =]
M7140 ~]
Prizm2 j
3270 ~]

0.0.0.0

no.oa

Farce Reload... | Thin Made...

Schedule...

Checking the Segment button restricts a terminal group to a range of IP addresses. The
IP Address can be any valid address on the segment as it is used only to identify the
segment. The setting of the Net Mask can be used to restrict the range. This feature is
useful for segregating terminal groups by location.

Setting Force Reload

Clicking on the Force Reload button forces all terminals within a group to be

automatically updated. The following warning message appears.

RF Sync Manager |

& Thiz will cauze all applicable fles to be reloaded on all

terminals in this aroup. Are you sure’?

Click on the Yes button to force the reload.
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Setting the Default Terminal Group

New terminals that have not yet been assigned to any group are initially assigned to the
default group in effect when they are booted.

Terminal Auto-Configuration

= E Terminal/Group Manager
G-
@ Befrezh
take Default
Delete
Rename

Any group can be made the default group by clicking on the group, and then clicking on
the right mouse button. Then click on the Make Default option.

Reassigning Terminals

After a terminal has been configured and assigned to the default group, it can be
reassigned to a new group by clicking on the terminal icon as shown below.

Terminal Auto-Configuration

=~ E Teminal/Group Manager
El@ Mew Group [Default]
= 017 241 75,157

48 Mew Groupi

Then, holding the mouse button down, drag the terminal icon to the desired group as
shown next.

Terminal Auto-Configuration

B B Teminal/Group Manager

Release the mouse button, which reassigns the terminal.

Terminal Auto-Configuration

= § Terminal/Group M anager
8 New Group [Default]

El@ Mew Group

207.241.78.

97

The next time the terminal is rebooted, it will be reconfigured as defined in the group
specification.
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Mobile Device Manager (MDM) Features
Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, and
RF Monitor features.

Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal
Messenger features depending on its authorization codes.

Untitled - Twin Client Manager

File Terminal Object Editore Setting: R Yiew Help
Dlﬁlnl .l'fll%l &l EI Authorization. ..
Aijrloader...

Screen YW atcher...
Terminal Messenger...
BF Monitor...

Server Transfer...

Select Screen Watcher, enter the terminal’s IP address, and click on OK.

Screen Watcher

Enter the |P Addresz af the Terminal:

|
k. I Cancel |

A screen will appear with a display resembling the terminal screen.

206.183.67.226 M= E

Statuz: Connecting...

Clicking on the Font button on the upper left brings up a screen in which you can modify
the font settings, as shown below.
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K E3

Ok I

Eant: Font style:
IHeguIar

Courier Hew

CoLrier
ltalic Cancel |
Finedsys Bold
T Lucida Conzole Bold Ikalic
B M5 Gothic
Terrminal _I
— Effects — Sample
[ Shikeout
[ Underline RaBbYyZz
Colar;
I- Black ;l Script;
IWestern ;I

Select Terminal Messenger from the Tools menu.

You may enter an Address Range in the From and To boxes on this screen. Click on Add
when finished.

Enter a message to send in the space provided, select the terminal to receive this message
by clicking on it in the Select Terminal(s) column, and click on the Send button to send
the message of your choice to the terminal of your choice.

See the example of the Terminal Messenger screen below.
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Terminal Messenger |

Enter the meszage to send:

Select Terminal(z]:

Addresz Range

Erarm: I Te: I
Add
Bemove | Select Al |
Remove Al | Unzelect All |

I1ze Chl and Shift keps to select multiple terminals

Setd | Cloze |

To remove a terminal from the list of terminals receiving your message, click on the
terminal number in the Select Terminal(s) column, and click on the Remove button.
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list.

Note: Use the Ctrl and Shift keys to select multiple terminals.

Click on the Close button when finished.
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Select RF Monitor from the Tools menu.

E3 untitled - RFMonitor M=l

File Edt Actions Toolz iew Help

Ready | [NUM 7

RF Monitor is an "Over The Air" diagnostic tool. It's used to collect diagnostic trace
information from RF terminals running PowerNet Twin Client software.

It runs on a Windows PC and will send a command to the RF terminal to start tracing.
The terminal, when it receives this command, will start sending the trace information
over the RF link to the PC that issued the command. This will be written to a file on this
PC that can be sent to us for analysis.

Click on File to Select Terminal or to Exit.

E3untitled - RFMonitor =] E3

A8 Edit Actions Toolz “iew Help

Select Terminal...

E it

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the
Terminal IP address and Terminal IP Port, and click on OK.
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Select Terminal

Terminal IP Address:

Terminal IP Part; I-I 802
k. I Cancel |

Click on Edit. Select Find, and/or Find Next to search for pieces of information in your
log, or select Clear to clear the search.

E3untitled - RFMonitor I =]

Eile @AW Action: Toolz “iew Help

Fitid .. (B
Eitd [WEwt Ea
LClear

Click on Actions to select Start Monitor or Stop Monitor.

E3untitled - RFMonitor M= B3
Fie Edit |FR00eg Tools Yiew Help

| Stark b anitar
Stop i omtar

—

Click on Tools to choose Set Debug Levels or Settings.

E3 untitled - RFMonitor =]

EIlE E':ht ECHDHS I|:||:||:5: HiEW ﬂElp
| ¢ | F SetDebuglevels.
[ Settings. .

The options in Set Debug Levels are shown below.
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%]

Debug Levels

General

Diizplay

Formatter

Dialog

Terminal [nkerface

Prezentation Space

[ atastream
[3270, 5250

SMA [3270)

o]

o i

1

&’
o [
o
L

The maximum log file size can be set under Settings.

Settings Ed |

bl asirmumn log file size [KE] |25EI _Ij
Cancel |

Click on View to show or hide the Toolbar and the Status Bar.

E2 untitled - RFMonitor M=l &3
File Edit Actionz Toolz Help
| . | =E| ® | v Tookar

[ w Statuz Bar
This is the Toolbar. It is found near the top of the screen.

[Ble «[F[2

This is the Status Bar. It is found at the bottom of the screen.

FReady l_ ML | S

Click on About RF Monitor under Help to view version number information. Click on
About Twin Client Manager under Help in the main menu to view the following screen.
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About Twin Client Manager x|

Twin Client b anager

; Yergsion 7.0.0
Copyright [C] 2004, Connect, [he.

Terminal Software VYersions:

bl anufacturer | T erminal | E mulation | YWerzion |
AL M7100 5250 7.0.0
Akl M7140 il .00
AL k7100 2270 700
AkL k7140 3270 7.0.0
AL M7100 WTERM 7.0.0
Akl M7140 WTERKM .00

RF Monitor is a very small program and does not even require installation. Just place it in
a directory on your PC and create a shortcut to run it. It will run on all versions of
Windows except V3.1 and Windows 95.

1. Move RF Monitor to a Windows PC with Network access to the RF terminal.

2. Run RF Monitor. (Create a shortcut or do a Start/Run.)

3. From the pull down menu, select File/Select Terminal.

4. Key in the RF terminal IP address and leave the port at 1802.

| Seleci-Tenminal ﬂ1

L

—

Terminal IP &ddress: |

Teminal IP Port; 1802
] | Cancel |

5. From the pull down menu, select Tools/Set Debug Levels. Set all levels to 9 except
Datastream and SNA.
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%]

L
Lt
=
L=

e
—
Lt
-
Lt
L

General

Digplay

Formatter

Dialog

Terminal Interface

Prezentation Space

D atasztream
[F270, 5250)

SHA [3270)

ok | Cancel |

o 1 P

6. With the RF terminal sitting at the Press Any Key prompt, select Actions/Start
Monitor.

7. Press a key on the RF terminal to open a session, and you should see trace data in the
RF Monitor window. When done, end the trace and the file will be named
tnxxx.yyy.log (where xxx.yyy is the last 2 octets of the RF terminal’s IP address) in
the directory in which RF Monitor was running.
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¥ 2151784187510p = RiMonitor, M=

File Actions Tools WView Help

B ?

88711 11:57:55.084808 Bms Log Started.

88711 11:57:55.04889 58ms BEGIH 5258 6.5.8 IBM-5291-1 TH E:itnut.cf =—
88711 11:57:55.888 280ms TH _key=878_.132< 8 vars (@)

88711 11:57:55.0088 5Oms Dialog File: *°

88/11 11:57:55.008 Bms Dialog "°

88711 11:57:57.08688 1760ms Connected To: 287.241.78.5

88711 11:57:57.0068 68ms tip snd: 2 bytes

51 @8 1.
88711 11:57:57.084808 SOms tip_rcu: 14 bytes
51 36 38 38 308 34 36 36 2E 33 2E 36 18 15 N6300466.3.6. .

88711 11:57:57.8488 68ms tip_setup: model 4B68A key 46 rev 630
B8/11 11:57:57.0888 168ms tip snd: 137 bytes

A B2 35 31 %A 82 41 31 A 65 42 31 30 38 30 5A 2.512.a12.B18862
B2 44 30 SA 85 46 33 32 34 30 SA 82 47 38 S5a 82 -DBZ_F324872 .GA2.
L9 B4 SA B2 4D 31 5A B2 4E 38 5A A9 58 34 2C 33 [.2.M12_.H8Z2_P4,3
32 2C 31 38 30 54 62 51 31 5A B2 52 38 59 82 42 2,1882 .01Z2.A8Y B
81 59 82 43 60 59 02 45 61 59 82 46 68 59 82 4N P i I, ] S ot e et
88 59 82 49 @1 58 83 42 08 00 58 @2 46 BA 58 @2 NoIX.B..K.F.X.
47 B8 58 B8 48 65 6E 67 6C 69 73 68 5A B2 56 6A G.%.-HenglishZ.\U.
A 11 48 31 2C 31 35 38 2C 32 38 34 38 2C 33 38 Z.H1,158,2848,38

Ready

Common Problems with RF Monitor

e The trace won’t start.

RF Monitor uses UDP to send commands to the RF device. On busy networks UDP
packets are not always delivered. The terminal can miss the command to start the
trace. Below are some things that can be useful.

a. Ping the RF terminal from the same PC before starting RF Monitor. (This seems
to "open" a path to the terminal.)

b. Start the monitor with the terminal at the Press Any Key prompt. (While the
terminal is at this prompt, it is not doing much and has a better chance of hearing
the start trace command.)

e | don't understand what this trace means.

The trace that this tool collects is engineering level information. It allows an end user
to collect information that can be analyzed by Connect engineering.

It will generally be requested by Connect support to help diagnose a reported
problem.

To be able to read and understand these completely, you need to have an
understanding of:
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a. Emulation protocols (IBM 5250, IBM 3270, DEC VT200, etc.)
b. PowerNet Twin Client products

c. RF Network concepts

d. Wired network concepts

e. Telnet sessions
f. TCP/IP

They are text files that can be read with any editor or viewer and can be useful to end
users and integrators even if they may not have all the requirements above.

¢ | have an intermittent problem and it could happen on any one of my 100
terminals. RF Monitor only does one terminal at a time. What can | do?

RF Monitor is not the right diagnostic tool for this type of problem. PowerNet
products have another diagnostic tool that can be used called the "Diagnostic Server".

This tool can be set up to run trace diagnostics on up to 300 terminals at the same
time. This tool will be provided as needed for systems under PowerNet support
agreement OR by T&M when they are not covered.

It also includes the service of a PowerNet support engineer.

Server Transfer is another feature. From the Tools menu, select Server Transfer.

Llntitled - Twin Client Manager M=l E3

File Temminal Object Editore  Setting: [EEEE Yiew Help

DI@IE' 'L,E'l%l ﬁl gl Autharization,..

Airloader. .

Screen YWatcher...
Terminal Meszenger...
BF karitar...

The FTP Settings screen appears.
FTP Settings

Server address: I

zer ID: Itec

Paszward: I““““““

Ok, I Cancel

To send object editor and configuration files from Windows to your Linux box, enter
your server address, and click on OK.
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Downloading Files

1. Make sure the terminal is powered On.

Note: If a client has just been loaded onto the terminal, the following screen appears.

TwinClient TNVT
(c)1991-2006 Connect
Keypress To Continue

2. Press Shift + ¢ to access the menu below.

Edit Menu Options

Edit License Key

Switch Client Modes
Run Client Emulator
Exit

3. If'the host IP address(es) were not pre-configured as described in the Setting the
Servers section of Configuring the Manager, or if you wish to change those settings
using the terminal menus, select the Edit Host List option and enter Host IP
address(es) as required. Press <F3> to save and <F7> to quit.

host 0
IP 207.241.78.5x_
Port

<F3> Save <F7> Quit

4. On the PC, click on Terminal and Send Program to Terminal.

Unl:iI:IEd - Twin Client Manager : =10 x|
File | Terminal ©Object Editors  Settings  Tools  View  Help
M Send Configuration Files ko Terminal
Receive File From Terminal
| St Program Files ko Terminal
1
5. Click on Yes or No.
Pl

& Wiould you alsa like to load the configuration files?

Yes Mo Cancel |
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6. Enter the desired information.

Server address: |2EI?.241 a4

Uzer D Iaml

Paszwiord: I"”’“""“‘

0k, I Cancel

7. Choose OK.
8. Power the terminal Off and then On.
The terminal is now ready to begin a Telnet session with the new files.

Note: If there are errors loading the AML terminal from Twin Client Manager, enable the
FTP and the Telnet servers (from the AML system menu under local settings)
before loading the files. The password is turk182 unless the user has changed it.
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Chapter 3 - Keypad Configuration

Diagrams

The keypad diagrams for the M7140 begin on the following page.
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5250
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Table

Key VT 3270 5250

a <a> <a> <g>

b <b> <pb> <b>

c <c> <c> <c>

d <d> <d> <d>

e <e> <e> <e>

f <f> <f> <f>

g <g> <g> <g>

h <h> <h> <h>

i <i> <j> <j>

j <j> <j> <j>

k <k> <k> <k>

| <|> <|> <[>

m <m> <m> <m>

n <n> <n> <n>

o <0> <0> <o0>

P <p> <p> <p>

q <q> <q> <q>

r <r> <r> <r>

s <s> <s> <s>

t <t> <t> <t>

u <u> <u> <u>

\/ <> <y> <>

w <w> <w> <w>

b'e <x> <x> <>

Yy <y> <y> <y>

z <z> <z> <z7>

A <Shift><a> <Shift><a> <Shift><a>
B <Shift><b> <Shift><b> <Shift><b>
C <Shift><c> <Shift><c> <Shift><c>
D <Shift><d> <Shift><d> <Shift><d>
E <Shift><e> <Shift><e> <Shift><e>
F <Shift><f> <Shift><f> <Shift><f>

G <Shift><g> <Shift><g> <Shift><g>
H <Shift><h> <Shift><h> <Shift><h>
| <Shift><i> <Shift><i> <Shift><i>

J <Shift><j> <Shift><j> <Shift><j>

K <Shift><k> <Shift><k> <Shift><k>
L <Shift><I> <Shift><|> <Shift><I>

M <Shift><m> <Shift><m> <Shift><m>
N <Shift><n> <Shift><n> <Shift><n>
(o) <Shift><o> <Shift><o> <Shift><o>
P <Shift><p> <Shift><p> <Shift><p>
Q <Shift><q> <Shift><q> <Shift><q>
R <Shift><r> <Shift><r> <Shift><r>

S <Shift><s> <Shift><s> <Shift><s>
T <Shift><t> <Shift><t> <Shift><t>

U <Shift><u> <Shift><u> <Shift><u>
\"] <Shift><v> <Shift><v> <Shift><v>
W <Shift><w> <Shift><w> <Shift><w>
X <Shift><x> <Shift><x> <Shift><x>
Y <Shift><y> <Shift><y> <Shift><y>
Y4 <Shift><z> <Shift><z> <Shift><z>
1 <1> <1> <1>

2 <2> <2> <2>

3 <3> <3> <3>

4 <4> <4> <4>

5 <5> <5> <5>

6 <6> <6> <6>

7 <7> <7> <7>

8 <8> <8> <8>

9 <9> <9> <9O>
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0 <0> <0> <0>

! exclamation <Shift><1> <Shift><1> <Shift><1>

@ at sign <Shift><2> <Shift><2> <Shift><2>

# pound <Shift><3> <Shift><3> <Shift><3>

$ dollar <Shift><4> <Shift><4> <Shift><4>

% percent <Shift><5> <Shift><56> <Shift><5>

A carat <Shift><6> <Shift><6> <Shift><6>

& ampersand <Shift><7> <Shift><7> <Shift><7>

* asterisk <Shift><8> <Shift><8> <Shift><8>

(_ left parenthesis <Shift><9> <Shift><9> <Shift><9>

) right parenthesis <Shift><0> <Shift><0> <Shift><0>

F1 <F1> <F1> <F1>

F2 <F2> <F2> <F2>

F3 <F3> <F3> <F3>

F4 <F4> <F4> <F4>

F5 <F5> <F5> <F5>

F6 <F6> <F6> <F6>

F7 <F7> <F7> <F7>

F8 <F8> <F8> <F8>

F9 <F9> <F9> <F9>

F10 <F10> <F10> <F10>

F11 <F11> <F11> <F11>

F12 <F12> <F12> <F12>

F13 <Shift><F1> <Shift><F1> <Shift><F1>

F14 <Shift><F2> <Shift><F2> <Shift><F2>

F15 <Shift><F3> <Shift><F3> <Shift><F3>

F16 <Shift><F4> <Shift><F4> <Shift><F4>

F17 <Shift><F5> <Shift><F5> <Shift><F5>

F18 <Shift><F6> <Shift><F6> <Shift><F6>

F19 <Shift><F7> <Shift><F7> <Shift><F7>

F20 <Shift><F8> <Shift><F8> <Shift><F8>

F21 --- <Shift><F9> <Shift><F9>

F22 - <Shift><F10> <Shift><F10>

F23 - <Shift><F11> <Shift><F11>

F24 - <Shift><F12> <Shift><F12>

A <A> <A> <A>

\4 <V> <V> <V>

< <4> <4> <4>

> <p> <p> <p>

Alt <Alt> <Alt> <Alt>

Backspace <Backspace> <Backspace> <Backspace>

Caps <Caps> <Caps> <Caps>

Ctrl <Ctrl> <Ctrl> <Ctrl>

Enter <Enter> <Enter> <Enter>

Esc <Esc> <Esc> <Esc>

Ins <Ins> <Ins> <Ins>

Menu <Menu> <Menu> <Menu>

Power <Power> <Power> <Power>

Shift <Shift> <Shift> <Shift>

Space <Space> <Space> <Space>

Tab <Tab> <Tab> <Tab>

~ tilde <Alt><Shift><qg> <Alt><Shift><g> <Alt><Shift><q>

° grave accent <Alt><Shift><w> <Alt><Shift><w> <Alt><Shift><w>

| vertical bar <Alt><Shift><e> <Alt><Shift><e> <Alt><Shift><e>

___underscore <Alt><Shift><r> <Alt><Shift><r> <Alt><Shift><r>

\ backslash <Alt><Shift><t> <Alt><Shift><t> <Alt><Shift><t>

| forward slash <Alt><Shift><y> <Alt><Shift><y> <Alt><Shift><y>

;  semicolon <Alt><Shift><u> <Alt><Shift><u> <Alt><Shift><u>

: colon <Alt><Shift><i> <Alt><Shift><i> <Alt><Shift><i>

{ left brace <Alt><Shift><o> <Alt><Shift><o0> <Alt><Shift><o0>

} right brace <Alt><Shift><p> <Alt><Shift><p> <Alt><Shift><p>
period <Alt><Shift><z> <Alt><Shift><z> <Alt><Shift><z>
period <.> <.> <.>

, comma <Alt><Shift><a> <Alt><Shift><a> <Alt><Shift><a>

- hyphen <Alt><Shift><f> <Alt><Shift><f> <Alt><Shift><f>
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+ addition sign <Alt><Shift><g> <Alt><Shift><g> <Alt><Shift><g>
¢ apostrophe <Alt><Shift><h> <Alt><Shift><h> <Alt><Shift><h>
“ quote <Alt><Shift><j> <Alt><Shift><j> <Alt><Shift><j>
[ left bracket <Alt><Shift><k> <Alt><Shift><k> <Alt><Shift><k>
] right bracket <Alt><Shift><I> <Alt><Shift><I> <Alt><Shift><I>
= equal sign <Alt><Shift><v> <Alt><Shift><v> <Alt><Shift><v>
? question mark <Alt><Shift><b> <Alt><Shift><b> <Alt><Shift><b>
< less than <Alt><Shift><n> <Alt><Shift><n> <Alt><Shift><n>
> greater than <Alt><Shift><m> <Alt><Shift><m> <Alt><Shift><m>
Attn - - <Alt><a>
Backtab — <Shift>< <> <Shift>< 4>
Clear --- <Alt><c> <Alt><c>
Del --- <Ctrl><Backspace> <Ctrl><Backspace>
Dup - <Alt><d>

End - <Alt><p> <Alt><p->
Erase eof --- <Alt><e> <Alt><e>
Erase inp --- <Alt><i> <Alt><i>
Field exit - - <Alt><e>
Field - - <Ctrl><«>
Field + - <Ctrl><p>
Fm --- <Alt><f> <Alt><f>
Help - - <Alt><h>
Home - <Alt><<€> <Alt><«>
Pa1 - <Ctrl><F10>

Pa2 --- <Ctrl><F11>

Pa3 - <Ctrl><F12>

Reset --- <Alt><r> <Alt><r>
Roll up --- - <Ctrl><A>
Roll down - - <Ctrl><V¥>
Sysreq - <Alt><s> <Alt><s>
Tab — <Shift><p> <Shift><p»>
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Chapter 4 » Error Message Resolution Guide

Twin Client Error Message Resolution Guide

Message Reason Solution Reference Tech Note

ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into the -
correct field.

ALPHABETIC ONLY; Trying to key a character that is not Ensure that you are entering input into the -
alphabetic. correct field.
MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into the -

correct field.

DECIMAL NOT VALID; Trying to key a Decimal (period).  Ensure that you are entering input into the -
correct field.

ALPHANUMERIC ONLY; Trying to key characters other than Ensure that you are entering input into the -
Alphabetic and numeric. correct field.

NUMERIC ONLY; Trying to key characters other than Ensure that you are entering input into the -
numeric. correct field.

ENTRY TOO SHORT; Trying to exit the field before itis  Ensure that you are entering input into the -
filled. correct field.
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Message Reason Solution Reference Tech Note

INVALID KEY; The key pressed is not valid. Ensure that you are entering input into the -
correct field.

MUST CLEAR FIELD; Trying to enter data in a field that  Ensure that you are entering input into the -
must be cleared first. correct field.
SCAN NOT ALLOWED; Trying to scan into a key only field. Ensure that you are entering input into the -

correct field.

KEY NOT ALLOWED; Trying to key into a scan only field. Ensure that you are entering input into the -
correct field.

ENTRY TOO SHORT; Trying to exit the field before itis  Ensure that you are entering input into the -
filled. correct field.
RECOVERABLE ERROR,; Encountered an error from which  Verify that your configuration settings for the -
you can continue. hardware being used, usually a printer and
cable issue.
UNRECOVERABLE ERROR; Encountered an error from which  Verify that your Network settings are correct T1113, T1114, T1161,
you can NOT continue. and you are in the correct mode using the T1171, T1187 and
correct Port. T1194
FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which  Notify Connect over the WEB incident -
you can NOT continue. reporting system.
Press any key\nFor More Details...; Press Enter for more information.  Advisory message. -
Press any key; Press a key to continue. Advisory message. -
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Error Message Resolution Guide

Message

Connection ERROR.\nREBOOT
MOBILE UNIT;

Disconnect ERROR.\nREBOOT
MOBILE UNIT;

RF Send ERROR.\NREBOOT MOBILE
UNIT;

RF Receive ERROR.\nREBOOT
MOBILE UNIT;

RF Check ERROR.\nREBOOT
MOBILE UNIT;

RF Timeout ERROR.\nREBOOT
MOBILE UNIT;

REBOOT MOBILE UNIT;

Reason

Could not Connect.

Could not Disconnect.

Could not Send.

Could not Receive.

Could not run the RF Survey.

Have been trying to contact the
host for the radio timeout period (2
minutes default).

Reboot the Mobile Unit do to loss
of connection.

Solution

Reference Tech Note

Verify that your Network settings are correct T1113, T1114, T1161,

and you are in the correct mode using the

correct Port.

T1171, T1187 and
T1194

Verify that your Network settings are correct T1113, T1114, T1161,

and you are in the correct mode using the

correct Port.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

Retry (Y/N)?; Try again. Try to send or receive again, or perhaps -
ensure that the printer is cabled to the
Mobile Unit and is on.
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Message

TIMEOUT\n\nSending Data;

TIMEOUT\n\nReceiving Data;

Host Received Data\nAwaiting App
Reply!;

* WAITING TO SEND *;

TCP Error Reading\nMAC
Address.\nREBOOT MOBILE UNIT;

Invalid TIP Command;

Session Ended\nBy User or Host;

Server Packet Error;

Reason

Mobile Unit out of the coverage
area.

Mobile Unit out of the coverage
area.

Mobile Unit has sent and received
an acknowledgement from the IP
stack and is waiting for the
application to return data.

Mobile Unit out of the coverage
area.

Could not obtain the Mac Address
from the Mobile Unit.

Bad internal protocol.

User, Host, application or network
has ended the session.

Bad Protocol detected.

Solution

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a host or network issue.
Troubleshoot the customer’s environment.
Probable causes are Database record
locking, application program failure, Host
failure or network failure.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Possible hardware, driver or stack problem
Contact the Mobile Unit manufacturer.

Notify Connect over the WEB incident
reporting system.

If the user did not end the session, most
likely host or network issues. Troubleshoot
the customer’s environment.

Usually a result of bad cabling, power or
faulty transceiver. Also, will receive this if
the Mobile Unit is in the wrong mode for

server operation.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message

Error receiving host\nlist from Server;

Unexpected Server\ndata received;

Error starting\nhost application;

Select Host or App;

Connecting...;

TCP Error\nReading IP
Address\nREBOOT MOBILE UNIT;

Printer start error;

Battery too low\nto print;

Paper Feed Error\nFix Then Hit Enter;

Printer Error\nPrint Ended;

Reason

Bad Protocol detected.

Bad Protocol detected.

Connected to the server but can
not connect to the distant end.

Need to choose your
Host/application destination.

Attempting to connect to the
Host/application.

Mobile Unit missing Network IP
information.

Could not initialize the printer.

Not enough power to print.

Paper in the printer is not ready.

Can not print.

Solution

Usually a result of bad cabling, power or
faulty transceiver. Also, will receive this if
the Mobile Unit is in the wrong mode for
server operation.

Usually a result of bad cabling, power or
faulty transceiver. Also, will receive this if
the Mobile Unit is in the wrong mode for
server operation.

Configure the server handler to access the
host application.

User selection required.

Advisory message.

Configure the Mobile Unit with the correct
network IP information.

Cable or power issue with the printer.
Replace the battery with a fully recharged
battery.

Replace the paper or rethread the paper in
the printer.

Check cable, battery, communication
settings and paper in the printer.

Reference Tech Note
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Message

User Count Exceeded.\n Session
Ended;

Primary Unavailable\nTrying Alternate;

APMAC.DAT Error\nSession Ended:;

MUIP.DAT Error\nSession Ended;

Missing Subnet IP\nSession Ended;

Error Opening File;

Telnet API\nnot found:;

Battery Low Warning\n\nReplace
Battery Soon;

No Host List.\nPress any key\nTo Edit
Host IP's;

Unable to Allocate\nFont Memory;

Reason

Possible authorization issue.

Solution

Verify that you have the correct number of
licenses for the number of Mobile Units you

are using.

First Host IP address not available Verify the host address.

trying the remaining addresses in
the Host list.

Access point Media Access Control Most likely a range, access point, radio,

error.

Mobile Unit IP Error.

Mobile Unit IP Netmask Error.

File is missing.

Program files are missing.

Not enough power to operate the
Mobile Unit.

Have not configured your target
hosts.

Mobile Unit does not have enough
memory to load the fonts.

host or network issue. Troubleshoot the
customer’s environment.

Most likely a Mobile Unit network setting
issue. Troubleshoot the customer’s
environment.

Most likely a Mobile Unit network setting
issue. Troubleshoot the customer’s
environment.

Verify that the configuration files are on the

Mobile Unit. Or perhaps there is a
hardware failure.

Reload program files.

Replace the battery with a fully recharged

battery.

Configure the target host IP addresses.

Reduce the fonts in use or expand the
memory in the Mobile Unit.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message

Font Loading Error;

Printer Not Ready\nPress R to
Retry\nC to Cancel Print;

Mobile Unit in\nDemonstration
Mode\nfor TwinClient;

Connected to Host;

Telnet Mode not\nsupported on\nthis
Mobile Unit;

Telnet Setup files\nnot found.
Reload\nfiles then switch;

Switched Client to\nTelnet Direct Mode;

Switched Client to\nServer Based
Mode;

Port 23 is only\nallowed in Telnet
Mode;

Not Enough Memory\nTo Run;

Press any key;

Reason

Could not load the font.

Can not print.

Running in demo mode.

Successful connection to the target

Host.

This Mobile Unit must be used with

a Connect Server.

Customer specific configuration

files are missing.

Mobile Unit running in Telnet mode

direct to the target Host.

Mobile Unit running through a
Connect server in Server mode
usually at port 1800.

Can not set the port to 23 in Server

mode. Port 23 is the standard
Telnet port.

Mobile Unit does not have the

capacity to run the program do to

memory restrictions.
Press a key to continue.

Solution

Ensure that the font is available to load.

Check cable, battery, communication
settings and paper in the printer.

Purchase a license from Connect.

Advisory message.

Order a Connect Server.

Reference Tech Note

Load the configuration files into the Mobile -

Unit from Twin Client Manager.

Advisory message.

Advisory message.

Advisory message.

Expand the Mobile Unit memory.

Advisory message.
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Message

TwinClient Telnet;

TwinClient Server;

TwinClient TN3270;

TwinClient TN5250;

TwinClient TNVT,;

(c) 1991-2006 Connect;

Edit Menu Options;

Edit Mobile Unit IP;

Edit Server/Host IPs;

Edit Radio Option;

Reason

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Menu Title.

Menu Option.

Menu Option.

Menu Option.

Solution

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Reference Tech Note
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Message Reason Solution Reference Tech Note
Edit License Key; Menu Option. Advisory message. -
Run Site Survey; Menu Option. Advisory message. -
Switch Client Modes; Menu Option. Advisory message. -
Run TwinClient; Menu Option. Advisory message. -
Exit to OS; Menu Option. Advisory message. -—-
Printer may not be\nplugged in Can not print. Check cable, battery, communication -
or\nturned on!; settings and paper in the printer.
OUT OF RANGE OF BASE; Mobile Unit out of the coverage Most likely a range, access point, radio, T1113, T1114, T1161,
area. host or network issue. Troubleshoot the T1171, T1187 and
customer’s environment. T1194
CONNECT SERIAL CABLE; Serial cable not connected to the  Check cable, battery and communication -
Mobile Unit. settings for the Mobile Unit.
REMOVE SERIAL CABLE; Remove serial cable from to the Check cable, battery and communication -
Mobile Unit. settings for the Mobile Unit.
PLACE IN CRADLE; Place the Mobile Unit in the cradle. Advisory message. -
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Message

REMOVE FROM CRADLE;

ACQUIRING CRADLE BUS;

Printer Out\nOf Range;

Connection Refused\nBy Host;

Connection Timed Out;

Connection Failed\nHost Not
Responding;

Connection Failed\nHost Unreachable;

Mobile Unit Out\nOf Range,
Unable\nTo Transmit;

Mobile Unit Out\nOf Range,
Unable\nTo Receive;

Reason

Remove Mobile Unit from the
cradle.

Attempting to access the cradle
through the serial port you have
configured.

Printer out of the coverage area.

You connected to the target host

but the host disconnected you.

You connected to the host but did
not logon in the appropriate time so

the host disconnected you.
Could not connect to the Host.

Could not connect to the Host.

Mobile Unit out of the coverage
area.

Mobile Unit out of the coverage
area.

Solution

Advisory message.

Advisory message.

Most likely a range, access point or radio
issue. Troubleshoot the customer’s
environment.

Verify that the configuration file has the
correct Mobile Unit type and New
environment variable set. Fallback to the
Connect Default to verify the connection.

Modify the Host parameters for login.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message

Printer Not\nResponding;

Printer Out\nOf Range;

Print Complete;

Reprint (Y/N)?;

WARNING;

Turning power off\nduring a

session\nwill cause the\nprogram to
restart;

Are you sure (y/n)?;

You Sure? (YyNn);

Domain Name Server\nNot Set;

Reason

Can not print.

Printer out of the coverage area.

Prompt.

Yes or No prompt for a reprint.

Prompt.

This Mobile Unit will disconnect the
session if powered off.

Yes or No prompt for a
confirmation.

Yes or No prompt for a
confirmation.

DOMAIN NAME SERVER not
configured.

Domain Name Server\nQuery Memory Memory error on the Mobile Unit

Error;

Solution

Check cable, battery, communication
settings and paper in the printer.

Most likely a range, access point or radio
issue. Troubleshoot the customer’s

environment. T1194

Advisory message.

Advisory message.

Advisory message.

Mobile Unit manufacturer limitation.
Advisory message.

Advisory message.

Advisory message.

Configure the Mobile Unit with the correct
network IP information.

Expand the Mobile Unit memory or return
the Mobile Unit for repair.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
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Message Reason

Domain Name Server\nQuery Sending Mobile Unit out of the coverage
Error; area.

Domain Name Server\nQuery Receive Mobile Unit out of the coverage

Error; area.

Domain Name Server\nUnavailable; Could not connect to the DOMAIN
NAME SERVER.

Error loading\nparameter file; Could not load the parameter file.

Could not open\ntelnet interface; Could not Telnet.

Could not set\mtelnet options; Could not use the Telnet
configuration.

Setup file\nsetting mismatch\nReload = Emulation program selected is not
Setup; compatible with the configuration
file on the Mobile Unit.

Display formatting\ntoo large Mobile Unit does not have enough
for\ncurrent screen; memory to run your configured
reformatted screens.

Mobile Unit\ninitialization error; Mobile Unit problem.

Solution

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Reload the correct configuration files.

Reload the program files.

Reload the correct configuration files.

Remove the emulation and configuration
files. Run clear Telnet on the Mobile Unit
then reload the Mobile Unit with the proper

emulation and configuration files.

Expand the Mobile Unit memory or order a

server from Connect.

Return the Mobile Unit to the manufacturer

for repair.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message

Host/App/Network\nclosed the session;

Disconnecting...;

Scan Barcode;

Enter Setup\nPassword;

Enter Profile \nPassword;

Host IP;

Host Name;

Port;

Mobile Unit Type;

Reason

Customer’s environment

disconnected the Mobile Unit

session.

Prompt.

Bar code scanning test.

Prompt.

Prompt.

Host IP address prompt.

Host name prompt.

Host IP port required.

Prompt.

WARNING: This will \nend any\ncurrent Prompt.

session;

Solution

Most likely a range, access point, radio,
host or network issue. Troubleshoot the
customer’s environment.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Enter target host IP address.

Enter target host Name.

Enter 23 for Telnet or 1800 for a Connect
server. Could also be a different number
depending on the customer’s environment.

Advisory message.

Advisory message.

Reference Tech Note

T1113, T1114, T1161,
T1171, T1187 and
T1194

T1113, T1114, T1161,
T1171, T1187 and
T1194
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Message

Continue (Y/N)?;

HOST ENTRY;

VT(100/220) Setup;

Mobile Unit Info;

Emulation Setup;

ANSI Setup;

Miscellaneous Setup;

Mobile Unit Type;

Control Codes;

Local Echo;

Reason

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Solution

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Reference Tech Note
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Error Message Resolution Guide

Message Reason Solution Reference Tech Note
<BK SP> Sends; Prompt. Advisory message. -

New Line Mode; Prompt. Advisory message. -

Insert Mode; Prompt. Advisory message. -
Autowrap Mode; Prompt. Advisory message. -

Cursor; Prompt. Advisory message. -
EMULATION SETUP; Prompt. Advisory message. -

Mobile Unit Type; Prompt. Advisory message. -

Local Echo; Prompt. Advisory message. -

Map Underline; Prompt. Advisory message. -

Break Key; Prompt. Advisory message. -
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Error Message Resolution Guide

Message

ANSI Setup;

Control Codes;

Backspace Key;

MISCELLANEOUS SETUP;

Test Options;

Login Options;

TEST OPTIONS;

Printer Test;

Scan Code Test;

LOGIN OPTIONS;

Reason

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Solution

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Reference Tech Note
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Error Message Resolution Guide

Message Reason Solution Reference Tech Note
User Name; Prompt. Advisory message.

User Password,; Prompt. Advisory message. -

ON; Prompt. Advisory message. -—

OFF; Prompt. Advisory message. -

Map; Prompt. Advisory message. -—

Don't Map; Prompt. Advisory message. -

Enable Break; Prompt. Advisory message. -

Disable Break; Prompt. Advisory message. -

7 bit; Prompt. Advisory message. -

8 bit; Prompt. Advisory message. -
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Error Message Resolution Guide

Message

Send Delete;

Send Backspace;

Mobile Unit Setup;

Scanner Options;

Program Options;

Special Options;

Beeper Options;

Exit to DOS;

Backlight Time;

Enter Key Action;

Reason

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Solution

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Reference Tech Note
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Error Message Resolution Guide

Message Reason Solution Reference Tech Note
Reset Options; Prompt. Advisory message. -

Font Size; Prompt. Advisory message. -

Portable Printer; Prompt. Advisory message. -

Reprint Option; Prompt. Advisory message. -

Data IDs; Prompt. Advisory message. -
Internal/External; Prompt. Advisory message. —

Modify Beeps; Prompt. Advisory message. -
Message Beeps; Prompt. Advisory message. -

Scan Identifier; Prompt. Advisory message. -

AID Scan Setup; Prompt. Advisory message. -
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Error Message Resolution Guide

Message

Long Scans;

Scan Send;

Yes;

No;

Normal;

Double Wide;

Double High;

Double High and Wide;

Errors Only;

Automatic;

Reason

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Solution

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Reference Tech Note
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Error Message Resolution Guide

Message Reason Solution Reference Tech Note
All Messages; Prompt. Advisory message. -
Reject; Prompt. Advisory message. —
Truncate; Prompt. Advisory message. -
Split; Prompt. Advisory message. -
Do Not Send,; Prompt. Advisory message. -
Always Send; Prompt. Advisory message. -
Last Field Only; Prompt. Advisory message. -
Internal; Prompt. Advisory message. -
External; Prompt. Advisory message. -
none; Prompt. Advisory message. -
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Error Message Resolution Guide

Message Reason Solution Reference Tech Note
monarch; Prompt. Advisory message. -

pddumb; Prompt. Advisory message. -

comtec; Prompt. Advisory message. -—-

rascal; Prompt. Advisory message. -
codewriter; Prompt. Advisory message. -—-
comtec(S); Prompt. Advisory message. -

User Name; Prompt. Advisory message.
Password; Prompt. Advisory message. -
Frequency: Hz; Prompt. Advisory message.
Duration: ms; Prompt. Advisory message.
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Error Message Resolution Guide

Message Reason Solution Reference Tech Note
Delay: ms; Prompt. Advisory message.

Select Scanner; Prompt. Advisory message. -

Setup Scanner; Prompt. Advisory message. -

Scan Test; Prompt. Advisory message. -

Scan Operation; Prompt. Advisory message. -

Laser; Prompt. Advisory message. ---
Contact/Pulse; Prompt. Advisory message. -
Contact/No Pulse; Prompt. Advisory message. -
Auto/Pulse; Prompt. Advisory message. -

Auto/No Pulse; Prompt. Advisory message. -
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Message

Wand Simulation;

VT100;

VT220;

SETUP;

Mobile Unit IP/Radio;

Host List;

NULL;

Reason

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Prompt.

Solution

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Advisory message.

Reference Tech Note
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